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Disclaimer 

Considerable time, effort and expense have gone into the development and documentation of S-FRAME. It 
has been thoroughly tested. However, in using the product (including manuals), the user understands 
and accepts that no warranty on the accuracy or reliability of the product is expressed or implied by 
the developers or distributors. Users must understand the assumptions used in the product, know its 
limitations, and verify their own results. 
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Manual Setup and Conventions 

Within the Manual there are screenshots and diagrams, emphasizing a certain step or results. In some cases, they 
indicate the correct data entry for a specific dialog: 

 

In other cases, they may show the expected output of a process: 

 

 

 
Notes: This symbol is used to highlight ‘’Notes’’ on specific topics throughout this manual. 

 

 
Good to Know: This symbol is used to highlight “Good to Know” facts throughout this manual. 

 

 
Need to Know: This symbol is used to highlight “Need to Know” facts throughout this manual 

 

 
Further Information: This symbol is used to highlight additional resources for specific topics. 
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Detailed Modeling Hints and Tips 

In this manual we summarize some of S-FRAME’s more important features, we also give you hints and tips that 
we think may:  

• help you to use S-FRAME more productively,  
• help you to avoid some of the difficulties which other users have encountered.  

Reviewing your 
model 

 During and after model creation there are many View settings that you can 
use to give you better feedback on the status and details of your model. You 
switch the most common options on and off by clicking on the appropriate 
status line buttons. Another particularly important feature when you are 
working with a 3D model is the facility to render it. This is described below. 

 
 

There is no one fixed set of options that will suit everybody and every 
type of model. You can easily switch components of the display on and 
off. If you have worked through the tutorials, you will be comfortable 
with this. 

 Throughout this hints and tips section, you may find that the screenshots show 
more information than those you see by default as you use S-FRAME. We have not 
used anything other than standard S-FRAME options to create these screenshots, 
so anything you see you can repeat by making the appropriate settings. 
Furthermore, during the examples, we show in this chapter you will see that the 
details differ between screen shots. This is deliberate and done to show the 
pertinent information with maximum clarity. If you are following an example, then 
your screen may contain different content to the ones we show. This will not affect 
the feature we are demonstrating. 

Rendering S-FRAME includes options which allow you to render any section as well as 
triangular and quadrilateral elements. 

S-FRAME uses the colors which you have defined for the current tool when 
rendering the members of your model; this enables you to see any anomalies in 
your structure very easily. The capture below illustrates the model when the 
Section Properties Tool is active. 

 

Figure 1. 

  

p. 1
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You can clearly see that one of the infill members has the properties of 
the top boom. 

 While the capture below shows the same model when the Member Type Tool is 
active. 

 

Figure 2. 

Provided that you take the time to set the colors you can get detailed information 
about your model quickly. 

You access the rendering options from the View menu. 

If you only check the Render option (and none of the other options), then S-
FRAME will only render those steel sections whose details come from the standard 
steel database tables. 

 

Figure 3. 

The rendering is detailed and can be a most useful way to view member 
orientations in 3D structures. In the above example we corrected the previous 

p. 2
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anomaly, and then we set the Length Shrink Factor to 0.75. You can also use the 
Scale Factor to exaggerate the cross section dimensions if necessary. 

You can also choose to render members whose properties do not come from the 
section database. In this case, S-FRAME renders the sections from the database as 
indicated above; S-FRAME renders all other sections using a large green I shape. 
This is to help you to visualize and confirm member orientation – the primary 
reason for the inclusion of this feature. 

Using Folders The screen shot below shows a complex structure where some effort has been 
made to sort the elements into logical groups. These can be selected/ 
manipulated/viewed using Folder Technology. 

 

Figure 4. 

Why Use Folders? Anyone who has tried to work with large models in analysis packages will 
immediately see the advantages of folder grouping. Once you have groups then 
all of the following become easy, even in the largest of models, on a group by 
group basis:  

• change section or material properties (or any other physical attribute),  
• add loads (for instance to the All Top Chords group in the above model),  
• review results graphically (for example examine the axial loads in one truss at 

a time),  
• print results (for instance for the Diagonals group of one truss in the above 

example).  

Once you start using folder grouping, you will wonder how you ever managed 
without it. 
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How do you create 
folders? 

Folder technology is completely flexible. You create and name the folders in the 
hierarchy you want. Then you select which elements go in each folder. It is very 
much like working with Windows Explorer. 

You can create or edit your folder hierarchy at any stage, both during model 
creation and in review after analysis. 

 
 

You can include any member or joint in up to 30 different folders – you 
are not restricted to one folder per member. Your model can contain up 
to 2000 folders. 

 The creation of folders is well covered in the tutorials and the detailed help 
system.  

An important part of the process of defining folder groups is the selection of the 
elements that go into each folder. Hence it is important that you have a good 
appreciation of the selection techniques available in S-FRAME – these are covered 
in the next topic. 

Making and 
clearing selections 

Understanding and using S-FRAME’s selection options to pick specific groups or 
types of members quickly is perhaps the most important skill that any S-FRAME 
user needs to master. It is not difficult, but we suspect that most users seldom 
employ the more powerful options to their maximum potential. 

Graphical Selection 
Options 

These are covered in detail within the help system and are summarized in the 
tutorials. 

 
 

For further information please see the “Acquainting yourself with 
selection” topic in the Introduction Manual – 2D Tutorial. If you have 
any doubts about these selection basics, we suggest you work through 
this section again. 

 If you want to use graphical selection in an advanced manner, then we strongly 
advise you to try to think 3 dimensionally. When you drag your 2D box across the 
screen, you are actually identifying a 3D slice through your structure. In practice, 
this means that you will often find it advantageous to adjust your 3D view’s 
orientation to make selection easier. 

 
 

To select all the members in an elevation, swap to a plan view first and 
then a single box selection does the job. 

To select all the members on a floor, swap to an elevation view first and 
then a single box selection does the job. 
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Menu Selection 
Options 

You will find a series of options directly on the Select menu which allows you to 
select or unselect all items of a given type simply. 

 

Figure 5. 

The menu also gives access to Select Special... and Unselect Special... options 
that are described in detail within the help system.  

We strongly recommend you take a little time to experiment with the various 
selection options. 

Folder Selection Essentially this is a way of repeating a previous selection of elements instantly. All 
you need to do is to create a folder, make your selection (using any method), and 
update your folder with your selection. Then you can select the same members 
again simply by clicking the folder. 

 
 

On the Status Bar, you will find an Automatically update open folder 
setting. While you are creating folders, you will find that this is extremely 
useful. However, we strongly recommend that you switch this off when 
you are working on other aspects of your model (and hence not focused 
on re-grouping) as otherwise, you may inadvertently change the 
grouping you have painstakingly created. 

 
 

As you build a model, you will generally assign similar section properties 
to members that will ultimately be loaded in the same way and then 
designed as a group. Therefore, you may want to use the Section 
Numbers (special) selection option to pick all members with the same 
section property in your model and then create a folder for that section. 
You can then load the members and review their results as a group 
easily. 

Using user 
coordinate 
systems 

This is an extremely powerful (although not new) feature which we think is 
underutilized and therefore we would like to take a little time to emphasize some 
of its uses. 

Creating and saving 
user coordinate 
systems (UCS) 

Moving the user coordinate system around lets you input model geometry relative 
to the most convenient origin. For all sorts of editing operations (moving, copying, 
generating, reflecting, etc.) it is invaluable. 
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Example For example, the simple frame below shows one wing of an office building. The 
second wing is angled at 45° and offset by 4 m from the extreme right-hand 
column of this view. 

 

Figure 6. 

If you want to work through this example with us, then load the model UCS 
Example Stage 1.TEL. 

 
 

You can move the user coordinate system by picking the UCS Tool and 
then clicking on any node. This moves the user coordinate system to 
that node but does not rotate it. 

 To translate the user coordinate system, rotate it and create the new wing takes a 
few simple steps:  

1. Left click on the UCS Tool and then click on the column base nearest to the 
required position. (Node 9)  

2. Right click on the tool and specify a rotation of –22.5° about the Z-axis then 
choose OK.  

3. Right click on the tool and specify a 2 m offset along X then choose OK. The 
coordinate system should now be in the position shown below, and we are 
ready to mirror the structure.  
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Figure 7. 

4. Select the Move option (either from the Edit menu or the buttons along the 
top). Specify reflection in the ZY-plane, making a copy. 

 

Figure 8. 

 
 

Remember – always take the time to ensure that all the details of the 
members you are going to duplicate are correct before you use copy, 
reflect, generate, etc. If any details are incorrect, then you will have to 
edit the original and any copies later. This will take you at least twice as 
long and potentially much longer if you have made many copies. 

 At any stage of this process, you can save the user coordinate system with any 
name you like. In this example the user coordinate system used for the reflection 
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was saved as Link Corridor and a further user coordinate system (shown above, 
and relevant to the second wing) was saved as Wing B. 

 
 

There is a drop down list to allow you to choose a saved user coordinate 
system quickly. 

 S-FRAME allows you to apply any saved user coordinate system as a preferred 
joint displacement direction to any group of nodes so that you can apply loading 
and review the results in a more meaningful manner. The capture below shows 
where the Wing B user coordinate system has been applied for this purpose. 

 

Figure 9. 

This means that you can easily add Joint Loads which are relative to the wing, 
rather than having to resolve and apply these in the global axis system. You will 
also find that the base reactions for wing B are appropriate to the orientation of 
the columns. 

If you want to review the model at this stage, then load the file UCS Example 
Stage 2.TEL. This model will be used as a basis to exemplify other features.  

The above only serves as a very quick introduction to the flexibility and power of 
the user coordinate system. This is a very powerful feature indeed and has a host 
of other applications. 

 
 

You could mix and match between Cartesian, cylindrical and spherical 
user coordinate systems within one model. 

 Control of the user coordinate system is also an important partner to many of the 
options discussed in this section of the documentation, including: 

• Creating and saving views, 
• Grids, 
• Viewing results for shell elements. 
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Using Views A View is a quick way of controlling a specific depiction of the whole or a part of 
your structure so that you can return to it easily.  

You can name and save different views of your model from any Graphical 
window. The view then becomes available in all Graphical windows. When you 
save a view it takes in all sorts of details including:  

• the current viewport scale,  
• the currently selected folder,  
• the current geometric label settings,  
• the current option settings,  
• the current grid settings,  
• the current user coordinate system,  
• the current projection type,  
• the window size and location relative to the overall S-FRAME window. 

 
 

When you create (or update) a view, then the current settings of the 
Options menu are stored and applied to all 3 Graphical windows. The 
settings of the View menu are stored for each Graphical window 
individually. Since the status line buttons are shortcuts to commands on 
both the Option and the View menus some Status Line settings update 
all the Graphical windows while others only update the current one. 

As mentioned above, when you save a view, S-FRAME automatically 
saves the current View menu settings individually for all 3 Graphical 
windows. This means that you can save a view while working in the 
Geometry window and then use the same view in the Graphical 
Results window. However, you may need to revise and update the View 
menu settings when you first use the view in the Graphical Results 
window. 

Why use Views? With the advent of Folder Technology, the new active Status Line and the Views 
and Grids toolbar which allow you to customize each Graphical window more 
quickly views have lost some of their importance. However the ability to create 
views still remains a very useful feature when used carefully as the examples 
below illustrate. 

 
 

Since the details stored for a view also include the active folder, it is easy 
to think of a view in terms of what you are viewing. If instead, you think 
of the view in terms of how you want the information to appear, then 
you will find that views are a much more powerful feature. You choose 
the appropriate view and then control what you want to show using the 
folders you have already created. 
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Example 1 If you want to work through this example with us, then load the model Views 
Example 1 Stage 1.TEL. 

 

Figure 10. 

This 4 story building is not a huge model. However, it is big enough to make a 
visual inspection of input and results difficult in some instances. With the 
following steps we create and save views to make our review process easier: 

1. First, we create folders that group together obvious subsets of our model. We 
have already done this, but if you like, you can add further groups.  

2. Select and maximize the Geometry window. Now ensure that the following 
status line options are switched on – Supports; Releases; Shrink Elements and 
Local X axis.  

3. Either click the View icon ( ) from the Views and Grids toolbar or right click 
over the graphics area and select Views from the context menu.  

 

Figure 11. 
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 4. Enter the view name Standard 3D and then click Add View.  
5. Now click View > Render... and switch rendering on. Be careful to check the 

option to render selected members only 
6. With the entire model rendered, repeat steps 3 and 4 to save a second view 

called Rendered 3D.  
7. Now switch to the Loads window, and you will find you can switch between 

these two view types by picking them from the list in the Views and Grids 
toolbar. Choose the Rendered 3D view and then click different folder groups 
and you will see that the members of those groups are rendered.  

8. Change back to the Standard 3D view and use the Status Line to switch on 
the options to hide unselected objects, view joint loads and view member 
loads. The view will become quite cluttered, but let’s repeat steps 3 and 4 to 
save this view as 3D plus loads. 

9. With this third view active, start selecting floors from the folder list, you should 
see views like the one below. 

 

Figure 12. 

Example 2 If you want, you can start working through the example at this point. If you want 
to do so, then load the model Views Example 1 Stage 2.TEL. 

1. Run a linear elastic analysis and then when the Results window is displayed, 
pick the Standard 3D view. Then open the diagrams and scale factors dialog 
and make the settings shown below. 
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Figure 13. 

 2. Save these settings and then click the Moment Diagrams Tool – you will see a 
very cluttered display.  

3. Increase the number of stations to 9 (don’t forget to click Accept Data ( )).  
4. Now use the Status Line to switch Hide Unselected Sections to On, and 

Display Legend to Off. The display will still be extremely cluttered but save 
this view as Detailed Results.  

5. With this view active, click on different folders and try swapping to different 
load cases or combinations. By adjusting the view direction, you can see 
detailed views such as that shown below. 

 

Figure 14. 

Since it is relatively easy to customize views as you go along, it is up to you to 
decide whether it is worth saving many different views. 
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If you find that you are forever setting up a series of standard view styles 
which are the same in many models, then you could save these in a 
start-up (or template) model (choose File / Save As and give a 
descriptive name such as TEMPLATE.TEL). You should ensure that this 
start-up model does not contain joints, members, irrelevant user 
coordinate system information and such like. Each time you want to 
create a new model you simply load the appropriate template model 
and hence the views it contains. 

Using grids to 
create your model 

You can define grid systems before you create a single joint or member. You can 
then use the grid systems to place joints and/or members by clicking on the 
appropriate grid intersection points. 

The process of creating and using grids has already been covered in some detail 
within the overview on creating a 2D structure, the 2D tutorial, and the 3D tutorial. 

Using grids to edit 
your model 

Irrespective of whether you have used grids to build your model, you can use 
them to great effect if you need to modify it. 

In the following example we will: 

• load a model where no grids have been defined, 
• automatically generate grids from this existing model,  
• use these automatically created grids to stretch the model. 
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Example If you want to work through this example with us load the model Grids Example 1 
Stage 1.TEL. 

 

Figure 15. 

1. Click the Edit Grids icon from the Views and Grids toolbar 
2. Right click on the folder None and choose New grid set from the context 

menu that appears.  

 3. Change the name of the new grid set to Foundations and then click on this 
grid set to be sure it is open.  

 

Figure 16. 

4. Now right click on Foundations and choose Auto Generate Grid Set from the 
context menu. 
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 5. Check the Display Grid option, and the Grid Definitions dialog should now 
look like that below. 

 

Figure 17. 

When we clicked Auto Generate Grid Set S-FRAME automatically located every 
joint in the current XY-plane and ensured that a pair of grid lines passed through 
that joint position. 

6. Now check Lock joints to grids and uncheck Lock grids. Set the X- and Y-grid-
increments to 1 m — this is the increment by which we will stretch this 
structure.  

7. Finally, click OK to close the dialog. You will see grid lines in drawn on the XY-
plane.  

 8. Select the grid that runs along the X-axis, and drag it (by holding the mouse 
button down) as shown below. 

 

Figure 18. 
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 9. Now release the mouse button and S-FRAME identifies and moves all of the 
joints that lie on a plane at 90° to the current XY-plane.  

 

Figure 19. 

10. Click the Undo icon from the Edit toolbar and S-FRAME returns all joints, 
members and grids back to their previous locations.  

11. If you want you can try moving the other grids around to further edit the 
structure at this point. 

 
 

By adjusting the increments (and zooming in if you are using small 
increments), you can make very precise adjustments to your model’s 
geometry in this way. 

 
 

You will find it difficult to move inclined elevations without distorting 
them. To do this successfully, you need to adjust your user coordinate 
system (the example below should help clarify this). 

 But what if we want to change our model’s floor levels rather its plan geometry. 
The current grid in the current XY-plane is no use to us. We need to change the 
plane and then create a new grid system appropriate to the floor levels. 

12. First, we choose the UCS Tool and access its dialog to rotate the coordinate 
system by 90° about the X-axis. The current grid system is immediately 
displayed in the new XY-plane, as shown below. 
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Figure 20. 

 13. Now we repeat steps 1 to 7 to access the Grids dialog, create the new grid set 
Elevation, and automatically generate its grid lines (which relate to the 
current XY-plane and close the Grids dialog).  

14. You will now have grid lines at each floor level, and you can drag these around 
as the exaggerated capture below shows.  

 

Figure 21. 

 
 

The above example also shows that the cross bracing becomes distorted 
as the grids move. Editing your structure by dragging grid lines is clearly 
a very powerful feature, but you need to be careful to watch out for side 
effects such as this. 
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Generating Arrays 
of Equally Spaced 
Floor Joists 

S-FRAME now includes facilities to allow you to create a series of infill joists quickly 
and easily. In many cases, you will be able to generate such joists across the entire 
width of a building if you need to. 

Example If you want to work through this example with us, load the model Floor Joists 
Stage 1.TEL. 

 

Figure 22. 

 
 

The standard bay centers are 6 m in the X-direction and 4m in the Y -
direction. 

 We shall add joists across this building using various options. 

To make the example as easy to follow as possible, we shall work in 2D mode and 
use a plane which only contains the floor (at an elevation of 3 m). 

1. Click the 2D icon ( ) on the Edit toolbar, make the following settings, click 
OK. 

 

Figure 23. 
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 2. Now we can zoom to the full extent of the structure.  

 

Figure 24. 

3. Now to create the joists. Click the Member Definition Tool and then proceed 
as explained below. 

 

Figure 25. 

4. You will see the Add Floor Joists dialog. Make the settings shown below and 
then click Ok. 
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Figure 26. 

 5. This creates the joist layout below. 

 

Figure 27. 

 
 

The joist layout includes the existing beams. S-FRAME recognizes this 
automatically and retains the existing members, rather than creating 
new ones. Also, because of the settings we made, S-FRAME does not 
create members in the bay where there is no beam in the ‘Source beam’ 
position. 

 6. We will now create a new series of joists which span parallel to the two nodes 
indicated above. If you switch on the display of the joint numbers, you will see 
that these are joints 20 and 41, we shall leave these off here since they clutter 
the display. Now click and drag as shown below. 

 

Figure 28. 
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 7. You will see the Add Floor Joists dialog. Make the settings shown below and 
then click Ok. 

 

Figure 29. 

8. You will see that this time the new joists are parallel to the line through the 
two nodes that we specified. 

 

Figure 30. 

9. Now to create the remaining floor joists, click and drag as shown below.  

 

Figure 31. 
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10. You will see the Add Floor Joists dialog. Make the settings shown below and 
then click Ok. 

 

Figure 32. 

11. You will see the layout of joists as shown below. 

 

Figure 33. 

But this is not the layout that we expected at all! So, what’s gone wrong? Well, we 
told S-FRAME to create 13 joists over a length of 24 m. However, S-FRAME has not 
been able to create the joists over the full 24 m since what would be the Target 
member in the last bay is not in line with the initial Target member we selected. S-
FRAME has recognized this and has created 13 joists over the reduced length. 
Furthermore, it has recognized the presence of the existing nodes in the Source 
members and has tied the new joists into these. 

  

p. 22



Altair S-FRAME 2021.1 
Modeling Hints and Tips

Proprietary Information of Altair Engineering 

 12. Click Undo twice, to completely clear the generation of this incorrect layout. 
Now click and drag again as shown below, note the change in direction. 

 

Figure 34. 

13. Complete the Add Floor Joists dialog as shown below and then click Ok. 

 

Figure 35. 

14. This layout of floor joists is more what we might expect, S-FRAME has created 
the joists as required but has still not created the joists in the final (skew) bay. 

 

Figure 36. 
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 15. So let’s create an arrangement in this bay. We don’t have to choose two 
beams along opposite sides of the bay; we can choose any two beams. So 
click as shown below. 

 

Figure 37. 

16. Complete the Add Floor Joists dialog as shown below and then click Ok. 

 

Figure 38. 

17. Now we get the arrangement of joists shown below.  

 

Figure 39. 

18. If you want, you can continue and define joists in the shaded area above.  
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The Clone Tool The Clone Tool dialog has been continually enhanced during the development of 
S-FRAME. It is now possible to extrude members (and shells or panels) between 
each generated set of nodes. Additionally, extruded members can be evenly 
subdivided by specifying more than 1 link. 

In the example below the truss was created using the truss generator options and 
then rotating and reflecting. The members were copied to the clipboard, and the 
Clone Tool was accessed with a left click then a right click. 

 

Figure 40. 

The dialog was completed as shown. 

 

Figure 41. 
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 With these settings the structure was generated as shown below. 

 

Figure 42. 

 
 

No offset needs to be specified for the first repeat. Duplicate members 
will not be created in this instance. 

In the view above, only the top chords are selected and rendered. The 
extruded members are given the current default section and material 
properties. 

Other generation 
options 

This section is simply a reminder of the options that S-FRAME provides to enable 
you to generate all or part(s) of your structure quickly. You can combine many 
options within a single model, and careful use will significantly speed up the 
creation of your model. 

You access all these generation options from the Edit menu, and they are covered 
in some detail within the help system. You can use the links below if you want to 
find out more. 

Create regular 
frameworks 

This option allows you to create a regular, basic beam and column (for example an 
office block), structure. 

Generate trusses The Truss Generator options allow you to create:  

• parallel chord trusses,  
• pitched chord trusses,  
• miscellaneous trusses.  
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Generate meshes The Mesh Generator options allow you to: 

• mesh curved surfaces (creating shell elements), 
• mesh circular cut-outs (creating shell elements),  
• mesh quadrilateral cut-outs (creating shell elements),  
• mesh panel elements (creating shell, plate, or membrane elements),  
• convert beam elements to meshable panels. 

Generate physical/ 
analytical models 

The Analytical Model options allow you to: 

• generate rigid diaphragm mass 

 
 

This does not produce any elements. Instead, it exposes a center of mass 
node to which you assign a lump mass and whose position you can edit, 

 • connect overlapping joints, which allows you to merge separate structures 
and in effect meld them together,  

• connect intersecting members, which automatically splits members that cross 
to create members that intersect at the crossing point. You would perhaps use 
this option before meshing your structure.  

Subdividing 
(selected) 
elements 

This option is particularly important when you automatically mesh panels as 
described later. However, you can choose to subdivide any or all selected 
elements irrespective of the presence of panels. 

The procedure for subdivision is simple: 

• select the elements you want to subdivide, 
• click on the sub-division toolbar button,  
• complete the dialog, specifying into how many segments you want S-

FRAME to divide each type of divisible element.  

 

Figure 43. 
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If you have applied loads to members or shells that are subdivided, then 
S-FRAME automatically recalculates the equivalent loads on the 
subdivided elements, if you have checked the Always preserve loads 
during element subdivision option in Preferences. 

 
 

We would advise you to exercise caution if you use this (much 
requested) feature. It makes it very easy to over model any structure 
(create a vast, slow and unmanageable model that does not increase the 
accuracy of the results but does greatly increase the amount of paper 
needed to print them). Before you use this tool, it is essential that you 
think carefully about your objectives for a particular analysis. As a 
general rule, we would recommend that you keep your model as simple 
as is possible while remaining consistent with these objectives. 

 
 

The model below is a simple example of Bad Modeling. 

Shells have been defined between the beams, and then both beams and 
shells have been subdivided to create meshed slab panels. 

This simple looking model (investigated by many users) presents many 
difficulties, for example:  

The loads will be dispersed logically, but this logical, analytical, 
dispersion will not always be what you expect For instance as the beams 
deflect the slab will start to carry load directly to the columns. As a 
consequence, the beam bending moments may be less than those 
anticipated in normal engineering practice.  

 

Figure 44. 
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Using rigid 
diaphragms 

There are several ways to model diaphragm action in S-FRAME: 

• using shell elements, 
• using slaving (linked degrees of freedom), 
• using equivalent (or fictitious) bracing elements. 

S-FRAME allows you to automate the third technique in various ways. 

Example If you want to work through this example with us, load the model Diaphragms 
Example 1 Stage 1.TEL. 

 

Figure 45. 

 
 

This model is based on the example we started earlier, see “To create 
and save user coordinate systems (UCS)” 

 To see the view above choose the Rendered 3D view from the list. 

Since we last saw the model some changes have been made namely:  

• additional steel across the link,  
• a simple grouping of members.  
• a single load case has been defined. This imaginary case (approximating 

to wind blowing on to the grid A) would cause translation and rotation of 
the floor plate.  
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Figure 46. 

 
 

The cross bracing is not rendered because it is formed from non-
database sections, namely flats. 

The loads applied to the right-hand wing are rotated to a different (and 
more relevant) user coordinate system using the Joint Displacement 
Tool. 

 If you review the structure, you will find that the extreme left and right-hand 
gables (grids A & F) are moment frames. All other connections are pinned. 

Now perform a linear static analysis of the structure. On reviewing the results, the 
best indication that something is wrong comes from examining the deflection 
diagrams – we would not expect to see a deflection of 39 m! 

 

Figure 47. 
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In some cases, S-FRAME will warn you that a structure seems to be 
unstable. Regardless of whether or not you see such warnings, it is 
always advisable to examine deflections for excessive movement. 

 
 

(Almost invariably true) If your results don’t make sense, spend some 
time looking at the deflections — are they going in the direction you 
expect? — are they of the expected magnitude? If the answer to either 
of these is No, then you need to check your modeling. 

 S-FRAME allows you to add diaphragms to your model in several ways, but there 
are two basic types of diaphragm:  

General Diaphragm - If you use this option you pick a series of nodes to define a 
plane (the number of nodes depends on the tool you are using). S-FRAME 
automatically finds all the nodes in that plane (and which do not lie in a region 
defined as a hole) and connects them all to a single node using a hidden system of 
rigid bracing. 

 
 

Whichever tool you use to define a general diaphragm, it is best to use 
nodes that are placed reasonably centrally within the area covered by 
the diaphragm. 

 
 

For new models, we would recommend that you use the Panel Element 
Tool to create a Rigid diaphragm as shown in the following 
example.The General diaphragm options were developed as a way of 
dealing with awkward geometries before S-FRAME could handle panels. 

 Rigid Diaphragm - If you use this option you pick a series of nodes that define an 
area within a plane, you can repeat this procedure to define as many separate 
areas as you like. S-FRAME automatically finds all the nodes in all the areas defined 
in the plane (and which do not lie in a region defined as a hole) and connects all 
the nodes within them to a single central node using a hidden system of rigid 
bracing.  

S-FRAME automatically calculates the position of the central node, the center of 
mass joint and adds this to the model. For dynamic analysis purposes, S-FRAME 
also calculates the lumped masses Fx, Fy, and Mz relative to the diaphragm plane 
and applies these to this joint. 

 
 

For detailed coverage of Mass modeling for vibration and response 
spectrum analysis see Vibration Analysis Options in Chapter 4 of the 
S-FRAME Verification Manual and Analysing and Designing for 
Earthquakes in Chapter 5 of the S-FRAME Verification Manual. 
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Creating a 
diaphragm 

You can add both rigid and general diaphragms to your model using the 
Triangular and Quadrilateral diaphragm tools, or alternatively you can use the 
Panel diaphragm options. We anticipate that this latter option will be the most 
commonly used, and so we will use it in this example. 

1. Select the Panel Element Tool, and then pick Rigid Diaphragm from the list. 

 
 

For linear elastic analysis, the diaphragm thickness and its material are 
irrelevant. You can set these to 250 mm and Concrete as shown above if 
you wish. 

 2. Click on the joints that define the outer perimeter of the first-floor area (2, 10, 
48, 40, 42, and so on) to create a panel the same shape as the floor. 

 3. Switch Hidden Surface Removal On (under the options menu), Shrink 
Elements Off, and adjust the diaphragm color (by right clicking on the 
Diaphragm Tool) to see the diaphragm highlighted as shown below. 

 

Figure 48. 

4. Now analyze the structure again, and a plan view of the deflected shape 
clearly shows translation and a degree of rotation which are more in keeping 
with our expectations. 
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Figure 49. 

 
 

The displacements for the right-hand wing are reported using the same 
user coordinate system as that used for the application of the loads. It is 
clear that the left-hand gable is not swaying as significantly as the right. 

 5. If you view the bending moments, you will see that the higher forces are in 
the right-hand gable, as we would expect for this load condition. 

 

Figure 50. 
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Using panels Panel options give you several ways of doing two basic things:  

• they allow you to define areas where diaphragm action applies,  
• they allow you to define panels for area loads 
• they allow you to define areas where you require automatic generation of 

meshes of plates, shells or membranes.  

Defining area 
loads 

New tools have been added to the 3D Geometry and 3D Loads tool boxes and a 
new panel type Area Load Only has been added to the 3D Panel tool. Working 
together these options allow you to create loads over large areas of your structure 
quickly and easily. If you want to add area loads, then you must follow a simple 4 
stage procedure: 

In the Geometry window: 

• ensure that the members you want to load are in the special Area Load 
Members folder, 

• define panels which cover the parts of your structure to which your area loads 
apply, 

• define the direction of the span for each panel you created above, 

In the Loads window: 

• apply the area loads to the structure. 

Example If you want to work through this example with us, load the model Area Load 
Stage 1.TEL. 

 

Figure 51. 

We shall add a vertical area load to the floor, excluding an area where there is a 
hole.  

To make the example as easy to follow as possible, we shall work in 2D mode and 
use a plane which only contains the top floor (at an elevation of 3 m) until we 
come to load our floor. 

p. 34



Altair S-FRAME 2021.1 
Modeling Hints and Tips

Proprietary Information of Altair Engineering 

 1. Click the 2D icon on the Edit toolbar, make the following settings, and click 
OK. 

 

Figure 52. 

2. Now we can zoom to the full extent of the structure. 

 

Figure 53. 

 3. Click the various group folders, and you will see that the Area Load Members 
folder contains no members, and the Floor Beams and Bracing folders contain 
the members you would expect.  

4. We shall now add the members which are to carry our area loads (that is the 
Floor Beams) into the Area Load Members folder. Click the Floor Beams folder 
to open it, then right-click it and choose Copy from the context menu that 
appears.  

5. In the Copy dialog, click the Area Load Members folder and then click Ok. This 
copies all the beams in the Floor Beams folder into the Area Load Members 
folder. Only members which are in this special folder can carry area loads. This 
means that the bracings (which are not in the Area Load Members folder) will 
not take any area load.  

6. Select the Panel Element Tool and access its settings dialog using any method.  
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Figure 54. 

7. We can specify area loads on any panel type (other than Hole), however, if we 
choose a panel type other than Area Load Only, this will add stiffness to our 
structure, and the panel will thus affect the analysis. For our example, we only 
want to use the panel to apply area loads to our structure. Therefore we select 
Area Load Only and click Ok.  

8. Now we define the panel over the entire floor area by clicking the joints 
indicated below. 

 

Figure 55. 
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 9. This creates the panel shown below (Shrink Elements is switched On, and so 
the box denoting the panel does not obscure the beams).  

 

Figure 56. 

10. Now we can define the hole, In the Data Bar choose Hole from the drop list, 
and then create the hole in our Area Load Only panel, by clicking as shown 
below.  

 

Figure 57. 

11. We now have a panel with a hole in it.  

 

Figure 58. 
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 12. Now we need to choose the way in which we want the load to span. Select the 
Span Direction Tool and access its settings dialog using any method.  

 

Figure 59. 

13. Choose the Tributary Area Colors that will enable you to see these clearly 
and then click OΚ to close the dialog.  

14. Now click on the center (square) node for the area load only panel that we 
created and S-FRAME instantly calculates the loading break down pattern for 
us and automatically takes account of the hole. 

 

Figure 60. 

 
 

At this point, you might want to investigate the distribution patterns 
that you can achieve with the other span direction settings. Simply 
choose the setting in the Data Bar, then click on the center node of the 
panel twice (the first click removes the existing pattern and the second 
one creates the new panel). When you have finished, please apply the 
Two Way spanning slab. 

 15. Switch to the Loads window view the structure in an isometric view, switch 
Shrink Elements On, switch Display member loads to On, and finally create a 
new load case titled Area Load 1. 

16. Use the Selection Tool to ensure that the area load only panel is selected. 
17. Now pick the Area Load Tool and define a load of value -5 in the Global Z 

direction using the Data Bar. 
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 18. Now click the center node of the area load only panel that we created, and 
you will see that S-FRAME adds the load, shows it at this node and also shows 
its distribution pattern. 

 

Figure 61. 

19. Select the Area Load Tool and access its settings dialog using any method. 
20. Check the Do not display tributary loads, Do not display span direction 

arrows and Convert area load to member loads boxes and then click OK to 
close the dialog. 

21. Now click on the center node for the area load only panel again twice. The first 
time removes the existing area load, and the second click reinstates it. This 
time, however, you will see that instead of showing the area load and 
distribution panel S-FRAME instantly calculates the loading break down and 
applies this to a series of member loads. 

 

Figure 62. 
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 22. If you zoom into the structure, focusing on the area around the hole, then you 
will see that the member loads also take full account of the hole. 

 

Figure 63. 

  

p. 40



Altair S-FRAME 2021.1 
Modeling Hints and Tips

Proprietary Information of Altair Engineering 

Connecting 
overlapping joints 
(merging 
structures) 

A new command (Connect Overlapping Joints) has been added to the Edit menu 
when you are in the Geometry window. This command allows you to fuse / merge 
overlapping joints and members together to create one joint and/or member. 

In the simple example below, we move the two structures together. 

 

Figure 64. 

 

Figure 65. 

 

 
 

Undo / Redo is fully supported during this operation. 

  

p. 41



Altair S-FRAME 2021.1 
Modeling Hints and Tips

Proprietary Information of Altair Engineering 

 Click Edit > Analytical Model > Connect Overlapping Joints and S-FRAME 
automatically:  

• merges joints 5 and 9 as joint 9,  
• merges joints 6 and 10 as joint 6,  
• reconnects members 9 and 11 to the merged joint 6 (and renumbers them as 

members 17 and 18 in the process).  
• reconnects member 13 to the merged joints 5 and 6,  
• deletes member 13 as it duplicates member 7,  
• Leaves members 4 and 18 as they are since they are not duplicates.  

 
 

These members overlap, but S-FRAME does nothing with them. It is up 
to you to decide the appropriate action to take 

 This operation only applies to selected objects which you pick using any of S-
FRAME’s selection methods. 

 

Figure 66. 

 
 

You can check for overlapping joints and members through File > 
Integrity Checks... (you can specify the tolerance you want the checks 
to use). You can use the Integrity Check options to delete overlapping 
elements. However, this is not a replacement for the merge option since 
if you choose to delete overlapping joints S-FRAME also deletes any 
members which are attached to a deleted joint as shown below. 
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Figure 67. 

 The key feature of Merge/Fuse is that it reconnects members to the retained joint 
or joints that were merged before identifying and deleting any duplicate members 
(those that run between the same pair of nodes). 

 
 

The main limitation of this feature is that loads are not merged. S-FRAME 
will delete any loads on deleted joints and members. You should always 
check your model’s loading after you use this feature. 

Connecting 
intersecting 
members 

As well as connecting overlapping joints S-FRAME also allows you to determine 
where two members intersect. It will split the members at these points, introduce 
new nodes as necessary and connect the split members to these newly created 
nodes. 

 
 

Undo / Redo is fully supported during this operation. 

If you want S-FRAME to preserve the loads during element sub-division, 
then you need to ensure that the Always preserve loads during 
element sub-division box of the Preferences dialog is checked. But see 
the important comment below. 

 To continue the simple example in the previous section, click Edit > Analytical 
Model > Connect Intersecting Members or the Connect Intersecting Members 
icon from the Edit toolbar. S-FRAME automatically splits member 18 at node 12 – 
creating member 19, and then removes the duplicate member 4. 
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Figure 68. 

 
 

With the correct Preferences settings S-FRAME splits the loads on 
member 18 and applies these to members 18 and 19. However, in this 
unusual example, the splitting of member 18 also means that it and 
member 4 are duplicate members. S-FRAME recognizes this and 
automatically deletes member 4, and therefore, any loads it carries will 
be lost. 

 
 

S-FRAME may take some time to determine member intersections on a 
large 3D structure. However, you can cancel the process at any time. 

 
 

If you are working with a large model, you can restrict the search for 
intersecting members to a 2-dimensional plane or to a selected subset 
of members. You can improve performance greatly if you restrict the 
feature in this way. 

Defining Moving 
Loads 

S-FRAME Professional edition allows you to run linear moving load analysis; that 
is moving load analysis on structures for which a linear static analysis is 
appropriate. 

In S-FRAME Enterprise edition you can also run Nonlinear moving load analysis, 
that is moving load analysis on structures for which a nonlinear static analysis is 
appropriate, for example, a cable-supported structure. 

In either case, you can combine the moving loads with any other static load cases 
or combinations. 

You can use multiple lanes for moving load analysis with different vehicles on each 
lane. You can configure the vehicles so that they move simultaneously (but at 
different speeds if you wish) along the different lanes. 
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 The following simplified example (a concrete deck with upstand edges) 
demonstrates the use of lanes in moving load analysis. 

 

Figure 69. 

 
 

We have used rendered shells to give a better graphical representation 
but have used beam elements for detailed modeling purposes. (The 
shells have very low material properties so that they don’t attract load or 
affect the analysis). 

 

Example If you want to work through this example with us, then load the model Moving 
Load Ex 1 Stage 1.TEL. 

The cross section below shows the basic model. 

 

Figure 70.  
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 The model consists of:  

• a large longitudinal spine element (Section 1 – SPINE) centered on the origin 
which supports the cross section.  

• Section 2 – RIGID ARMS is a rigid element which extends to the true physical 
boundary of the spine.  

• Section 3 – 1M WIDE DECK is a 1 m width of the cantilever deck, and  
• Section 4 – 1M WIDE BARRIER is a 1 m width of the upstanding barrier,  
• Section 5 – LACER BEAM is a beam which allows the load to be dispersed and 

shared between the 1 m wide slab cantilever elements,  
• Section 6 – SUPP COL is the columns which support the spine elements.  

At this point, we would suggest that you spend a little time familiarizing yourself 
with the structure and its grouping. When you have done this, switch to the Loads 
window, and you will find that the model contains a Dead and a Live load case and 
a single combination of these. 

With all this information already defined, we can proceed to define our moving 
load case.  

1. Create a new load case, giving it the name Moving Load. 

 2. Now click the Moving Load Tool and then right click it to open its dialog as 
shown below.  

 

Figure 71. 

 

3. Open the wheel load pattern file Movedata.DML. (C:\ProgramData\S-FRAME 
Software\Data Bases\Vehicle) 

 
 

If you are not sure how to do this refer to the Help System. 

You might wish to take this opportunity to review the moving load 
features using the help system. 
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 4. Now we define our first moving load in lane 1 (running along lacing members 
208 to 221). 

 

Figure 72. 

 
 

We constructed the model carefully so that the lacing members are 
numbered sequentially. 

 5. Once you have selected and completed all details in the dialog exactly as 
shown below, click Add – you have now defined the loads on lane 1. 

 

Figure 73. 

 
 

The Increment defines the steps in which the leading axle moves across 
the members. If you want to achieve simultaneous lane loading, then 
you must set the same increment for each lane 
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 6. The moving load in lane 2 runs from lacing member 264 to 277. This is a 
different load pattern (heavier loads and more axles). Complete all details as 
shown below and then click Add again. 

 

Figure 74. 

The dialog now shows the loads in lane 2. 

 
 

You can use the Lane No. list to select and view the loads in either lane. 
To edit the loads in either lane, simply select the lane from the list, make 
the edits and then click Update. 

 7. Click OK to close the Moving Load Tool dialog.  
8. Analyze the model by clicking the Analyse icon on the Edit toolbar.  

 9.  Make the settings shown below and then click Ok. 

 

Figure 75. 
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During the analysis, you will see that S-FRAME analyzes a whole series of 
additional load cases. These are for each increment of the moving load. 

Reviewing moving 
load results 

If you want to work through the remainder of this example with us, then we would 
suggest that you load the model Moving Load Ex 1 Stage 2.TEL. This should be 
exactly the same as the one you have just created, but in case you made any other 
changes inadvertently we suggest that you open the Stage 2 model and work with 
it. 

After analysis, you can step through all the cases generated as the loads move 
along their defined paths. When viewing load cases a separate case is created for 
each load step. The picture below shows the fourth step. At this stage, only the 
leading axles have started along their paths. 

 

Figure 76. 

 
 

By picking SPINE from the drop down list, we tell S-FRAME that we only 
want to see these results. 
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 Later, at step 26, all axles of both moving loads are on the deck. 

 

Figure 77. 

When viewing load combinations, a separate combination is created for each load 
step. The picture below shows the 26th step again. 

 

Figure 78. 

 
 

This time we pick the cantilever deck elements, note how the moment 
peaks adjacent to the wheel loads. 
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 Although there is no analytical reason for defining shell elements, they provide a 
visually informative means of viewing the deflections at each step. 

 

Figure 79. 

You can use S-FRAME to generate envelope diagrams covering a selected range 
or all of the moving load steps. The diagram below shows a sectional view of the 
spine beam has been generated with an envelope diagram and the optional max/ 
min text. 

 

Figure 80. 

As noted at the start of this section, S-FRAME can also perform a nonlinear analysis 
of moving loads. S-FRAME can combine the results from this analysis with those of 
other load cases or combinations. 
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 The capture below shows the settings for a Nonlinear Static Moving Loads analysis 
(which uses the Full Newton-Raphson method). 

 

Figure 81. 

 
 

You must specify various increment and convergence criteria which are 
appropriate to this analysis type. 

 The other settings tell S-FRAME to combine the results of the analysis with those of 
the Dead + Live combination. To achieve this analysis S-FRAME adds the loads for 
the current step in the unfactored rolling load case to the factored loads from each 
load case in the combination and then does the analysis for this step. 

 
 

If you want to factor the rolling load, then you can do this by adjusting 
the Load case Scale Factor in the Edit Load Status dialog available 
from the Edit menu or by using the Edit Load Status icon from the 
Views and Grids toolbar. Both of these options are only available in the 
Loads window. 

 After analysis, you can view the results for load cases or for combinations by 
picking the appropriate icon ( and respectively) from the Edit toolbar, and 
choosing the particular details from the list in the Views and Grids toolbar. 

 
 

This means that design in S-Steel and the links to the concrete design 
programs all now support design for rolling load combinations. 

 
 

For nonlinear analysis, S-FRAME has to solve every load case and 
combination separately since the principle of superposition does not 
apply. This means that a nonlinear analysis will take longer than a linear 
one. 

 Finally, you can generate influence line diagrams from any unit (single wheel) 
rolling load case.  
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If you loaded the model Moving Load Ex 1 Stage 2.TEL, then this already contains 
such a load case called Point Load. This load case is inactivated. You can reactivate 
it using the Edit Load Status dialog.  

This load case contains a single wheel load which moves along members 208 to 
221 (see earlier diagrams) in 0.5 m steps. 

 
 

The wheel load can be any value you like, 1 kN, 100 kN, 6.357 kN and so 
on. The results S-FRAME calculates relate to this load value; that is they 
are not limited to a load value of 1. 

Reviewing and 
Printing Results for 
Beam Elements 

In the Graphical Results window S-FRAME can show much detailed information 
for your structures, be they large or small. 

In general, you will find that the screen clutter increases directly proportionally to 
the amount of information you ask S-FRAME to include. As a guiding principle, we 
would recommend that you reduce the number of members whose results you 
require as you request more information for those members. You will find that this 
principle is covered in some detail in the Tutorial and elsewhere in this Hints and 
Tips section. 

 
 

The combination of View and Diagram options and settings gives you 
incredible flexibility together with the ability to save your favorite 
settings and to swap and change between them. 

Using Shell 
Contours and Slab 
Design Contours 

When you start working with models containing shell elements, you will soon find 
it is essential to organize and control your views of the results. The options 
available allow you to see results for these element types in a meaningful and 
informative manner.  
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Using Contours for a 
Flat Slab 

In this example, we introduce guidance on modeling a regular slab, in order to 
achieve a finite element solution which correlates with an empirical code design 
solution. While this guidance relates to a specific code and a particular simple 
regular grid layout, there is no reason why a similar approach would not work 
equally well for irregular slab layouts, and for different design codes. The particular 
regular floor layout is shown below. 

 

Figure 82. 

 In industry we see more and more emphasis being placed on modeling flat slabs 
using a finite element analysis. The reasons for this are many, including:  

• the need to provide reduced structural zones,  
• the need to incorporate the potential that flat slabs provide for fast formwork 

erection and construction,  
• the need to provide unobstructed service zones,  
• the need (perhaps) to be able to handle irregular column layouts. 
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 BS 8110 and CP 65 provide guidance allowing you to idealize and analyze an 
orthogonal flat slab structure. If you are going to use this guidance you must:  

1. be able to identify column strips and middle strips,  
2. create and analyze a sub-frame (as you would for any other beam and column 

sub-frame model),  
3. cater for pattern loads directly or apply moment re-distribution to the results 

based on the analysis of that load case where all the spans are fully loaded,  
4. proportion the resulting forces between the column strips and middle strips 

which you identified earlier in an empirical fashion.  

For an orthogonal structure, such as that shown below, it is easy to visualize an 
arrangement of the two strip types. 

 

Figure 83. 

But for an irregular structure, this is far less straightforward! In the example below 
there is no obvious orthogonal system of strips. 

 

Figure 84. 

In fact, for this structure, a system of triangular zones radiating from a core that 
combined the walls and the column would be more rational. Codes give no way to 
deal with unusual arrangements such as this in a simplified fashion.  
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These are the buildings about which we are asked regularly. To generalize:  

• virtually no-one shows us a nice regular layout,  
• the engineer has usually tried and failed to apply the code’s strip idealization 

in a way with which he is comfortable,  
• the engineer, therefore, wants to turn to a finite element package in order to 

perform a more sophisticated analysis.  

However, although a finite element analysis is more sophisticated, it is not a 
design methodology. 

Any finite element analysis will yield results that need to be used carefully, but 
there appears to be little authoritative guidance on this, and so the engineers we 
speak to are hoping that we can provide this. We can only offer as guidance the 
following summary of important aspects of which you need to be aware.  

So, where should we start? - Many of the questions we face relate to highly 
irregular layouts where the results are not as expected – typically the results show:  

• high hogging moments, and/or  
• small sagging moments.  

However, in such cases, there is no strong basis for suggesting what the correct 
results should be. 

So the best place to start has to be with a regular structure where we can compare 
the expected results based on long-standing and proven code idealizations with 
the results from our finite element analysis. We shall concentrate on the model 
shown below: 

 

Figure 85. 

The details for this regular structure are:  

• it is a 5 bay by 5 bay structure  
• it has 8 m bays in both directions,  
• it is a top floor and thus has columns only below it,  
• the column length is 3 m,  
• these columns are of a 300 mm square section,  
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• the slab is 300 mm thick,  
• the Dead load (G) is = 8.7 kN/m2,  
• the Imposed load (Q) is 5.0 kN/m2,  
• The ultimate load is thus 20.18 kN/m2 (1.4xG + 1.6xQ). 

The BS 8110’s strip method - For a structure as simple as this the code provides 
alternative simplified methods.  

The very simplest method is outlined in clause 3.7.2.7 and allows strip design 
moments to be determined using the coefficients in table 3.12.  

The more complex option requires an idealized frame analysis that is more tailored 
to the geometry of each specific building. This is the approach we will examine 
here. 

 The Analysis Model - Clause 3.7.2.2 indicates that the idealized 2D frame analysis 
should be based on the gross section properties of the columns and the slab strips 
(where the strip width is equal to the full panel width – 8 m in this case, 300 mm 
thick). The strips are loaded with the full slab load. 

We can create and analyze this simple frame in S-FRAME. 

 

Figure 86. 

Basic Analysis Results - The results of a linear elastic analysis for the case with all 
spans fully loaded are shown below. 

 

Figure 87. 

Since the results are those for a linear elastic analysis clause 3.7.2.1 (which itself 
refers on to clause 3.5.2.3) applies and you need to make a 20% redistribution of 
moments from the supports into the spans. 

 
 

This redistribution is required to account for the pattern loading effects. 
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 The effects of this redistribution are detailed below: 

 Support 
1 

Span 1 
Support 

2 
Span 2 

Support 
3 

Span 3 

Moments before 
redistribution  

91 -763 1057 -363 830 -461 

Moments after redistribution  73 -877 846 -550 664 -627 

Change  -20% +15% -20% +52% -20 +36 

Table 1. 

Proportioning of Design Moments in Strips - BS 8110 Table 3.12 indicates how 
the design moments should be proportioned between column strips and middle 
strips. 

 
 

Clause 3.7.3.1 also requires that the central half of the column strip be 
designed for 2/3 of the hogging moment. 

 The distribution of design forces in each of the 4 m wide strips is therefore as 
tabulated below: 

 Column Strip Middle Strip 

Maximum Hogging 
(negative)  

50% in 2 m wide central 
section of strip  

25% over full 4 m width of 
strip.  

Reduced Hogging 
12.5% in 1 m wide edge 
sections of strip 

 

Maximum Sagging 
(positive)  

55% over full 4 m width of 
strip  

45% over full 4 m width of 
strip  

Table 2. 

or alternatively representing this graphically. 
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Figure 88. 

Proportioning the moments to the strip regions thus gives: 

 Support 1 Span 1 Support 2 Span 2 
Support 

3 
Span 3 

Moments after 
redistribution  

73 kNm 
877 

kNm 
846 kNm 

550 
kNm 

664 kNm 
627 

kNm 

Column strip 
centre zone (2 m 
wide)  

Special 
provisions 

apply 

55% 
120 

kNm/m 

50% 212 
kNm/m 

55% 76 
kNm/m 

50% 166 
kNm/m 

55% 86 
kNm/m 

Column strip 
edge zones (2x1 
m wide)  

0 ditto 
25% 106 
kNm/m 

ditto 
25% 83 
kNm/m 

ditto 

Middle strip (4 m 
wide)  

0 
45% 99 
kNm/m 

25% 53 
kNm/m 

45% 62 
kNm/m 

25% 42 
kNm/m 

45% 71 
kNm/m 

Table 3. 

 Review - after performing the moment redistribution and proportioning the 
relative magnitudes of design moments it may be worth recognizing the following 
relationships. 

Sagging Moments - the sagging moments vary from span to span with the 
highest moments occurring in the end spans. 

• For a regular layout like this internal span, moments are restricted to around 
70% of the end span moments. 

• The moments only vary in the proportion of 45/55 (a difference of 20%) in any 
given span, (comparing the column strip to the middle strip). 

• A possible reinforcing strategy to cater for these sagging moments could, 
therefore, be to provide something like 70 to 80% of the peak sagging 
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moment across the entire slab as a general provision. This general provision 
should be adequate almost everywhere and can be increased locally where 
necessary. 

Hogging Moments - the hogging moments intensify rapidly as you approach the 
support. 

• In the middle strip, the design hogging moment (53 kNm/m) is less than half 
of the peak sagging moment (120 kNm/m). 

• The peak design hogging moment over the column (212 kNm/m) is a little less 
than double the peak sagging moment (120 kNm/m). 

• A possible reinforcing strategy to cater for these hogging moments could be 
to provide reinforcement for a hogging moment of around half the peak 
sagging moment across the entire slab as a general provision. Additional 
reinforcement can then be placed over the columns as necessary. 

A finite element approach - In our finite element analysis we are going to build 
larger, more complex models. We, therefore, need to think about the properties 
which we are going to use in these. 

We need to use appropriate section properties for our members. BS 8110 suggests 
that you should use consistent properties. However, this may not be appropriate 
for checking deflections. However, the choice of section properties must be your 
decision. We would suggest that if you are concerned about deflections, then you 
should consider this from the beginning. If you model in such a way as to give the 
slab deflections, then the self-same model should also give the design moments 
as well. 

Let’s consider the deflection in more detail. In general, deflection results for flat 
slabs (or any concrete structures) should be regarded as estimates no matter what 
type of analysis you use. The unknowns associated with the accuracy of the 
material properties dictate this. For example BS 8110 indicates that for C40 grade 

concrete, E (short term) might lie somewhere in the range 22 kN/mm2 to 34 kN/ 

mm2. 

The stiffness of your members also needs to be modified to allow for creep and 
cracking. CIRIA Report 110, Design of Reinforced Concrete Flat Slabs to BS 8110 
gives some guidance on adjustments that may be appropriate to allow for both 
creep and cracking. In simple terms, this suggests reducing E (short term) by half 
to two-thirds to allow for creep and also reducing I by half to allow for cracking. 
This means that the stiffness (EI) of your members should be reduced by a factor of 
between 4 and 6. Thus an overall stiffness adjustment factor of between 0.16 and 
0.25 would be applicable. 

We can adjust the stiffness of our members by only adjusting the value of E, so for 

C40 grade concrete an E-value anywhere in the range of (0.16x 22kN/mm2) =3.5 
kN/mm2 to (.25x34 kN/mm2) =8.2 kN/mm2 might be appropriate. 
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Some companies have internal guidelines that their engineers adhere to in this 
regard. 

If you want to review this subject further, you will find that the reports on the 
results of the Cardington Institute Concrete Building are of interest. We would 
particularly recommend the papers by Messrs Hossain and Vollum, in particular, 
the paper Prediction of Slab Deflections and validation against Cardington.  

These studies indicate that propping and in particular the timing of prop removal 
have an important influence on slab deflections.  

In the absence of better data, this work appears to conclude that long-term 
deflections can be estimated on the basis of a linear static analysis with an 
adjusted EI value. Suggested adjustments are towards the bottom end of the 0.16 
to 0.25 range. If a slower pace of construction was anticipated, or if construction 
were more controlled it is feasible that higher multipliers could be justified.  

The deflections that you review should be for the combined dead and imposed 
loading case under serviceability loading.  

To do this, you could create a separate un-factored combination, or, you could 
review deflections based on the factored combination. If you adopt this second 
approach, then you need to account for the load factors in this combination. To do 
this, you need to increase the stiffness adjustment factors by a factor of between 
1.4 and 1.6.  

Hence in the following example, we will use an adjusted E value of 7 kN/mm2 for 
the slab. This value is on the low side of the figures discussed above.  

For the columns, we will use an uncracked long-term modulus of 14 kN/mm2. 
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Example If you want to work through this example with us, then load the model Flat Slab 
Model Stage 1.TEL. 

 

Figure 89. 

At this stage, the columns have been defined, as has the flat slab panel. To create 
our shells we need to mesh this model.  

Meshing - By creating a panel sub-dividing the meshed shells we can create a fine 
mesh very quickly. Generally, we would advise you to try to ensure that there are 
at least 6 segments between adjacent column/support positions. If you are in 
doubt, we would always advise that you mesh a little more finely. 

1. Click Mesh > Mesh Panel Elements or click the Mesh Panel Elements Tool (

). S-FRAME meshes the panel as shown below. 

 

Figure 90. 

This mesh is far too coarse; we, therefore, need to subdivide the shells to create a 
mesh which is finer. 
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 2. Click Edit > Subdivide... or click the Subdivide Selected Elements Tool (
).Make the settings shown below and then click OK. 

 

Figure 91. 

The resulting fine mesh (shown in a zoomed view below and with Shrink Elements 
switched On and with Display local ‘x’ axis switched Off) is now suitable. 

 

Figure 92. 

Now we can proceed to load our structure. Access the Loads window and apply a 
pressure load of -8.7 kN/m2 in the Global Z direction into the Dead load case and 
a similar load of value -5.0 kN/m2 into the Live load case.  

If you want to pick up the model at this stage, then load the model Flat Slab Model 
Stage 2.TEL  
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 3. Click the Analyze ( ) icon to perform a linear static analysis on this model.  

Once the analysis is complete and you have closed the Solution Summary dialog 
you will see the Graphical Results window. 

4. Since we are interested in the shells, the most intuitive way to view the results 

is to use the Shell Contours Tool ( ), pick Z-Deflection from the list of 
available contours and click Accept Data to see a contour map of the Z-
deflections. 

 

Figure 93. 

 
 

This analysis’ results give us an estimated long-term deflection around 
60 mm, but remember that adjusting E for the slab concrete will have an 
almost directly proportional effect on this result. In addition, creating a 
more detailed column-head model could also have an impact on 
deflections. 

If your display does not look like this, then click Settings >Diagrams... 
and make the settings shown below before clicking OK. 
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Figure 94. 

  Next right click the title of the Legend and then pick Properties... from 
the context menu. Make the following settings in the Contour Diagram 
Factors dialog. 

 

Figure 95. 

 For the remainder of this example check the Superimpose undeformed geometry 
option and uncheck the Superimpose contours on deformed geometry options in 
the Contour Diagram Factors dialog. Your screen should now look like that 
below. 
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Figure 96. 

 5. Now pick the option to display Mx contours from the list of available contours, 
and then view your structure from the top. You should now see the display 
below. 

 

Figure 97. 
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The maximum (centroidal) Mx moment is +181 kNm and the minimum 
Mx moment -102 kNm. 

The maximum (nodal) Mx moment is +424 kNm and the minimum Mx 
moment -109 kNm. 

 Interpretation Options - 3 of these options are provided in the Contour Diagram 
Factors dialog (see the previous capture) and Concrete Steel Area Contours Design 
Parameters. 

 

Figure 98. 

In this model the peak design hogging moments vary as follows:  

• Centroidal — 181 kNm  
• Average — 303 kNm  
• Nodal — 424 kNm  

This range relates to the variation of nodal forces that you see for each shell. 
Typically shells attached to a column head will have a wide variation (but this is 
dependent on the mesh density at that column head). 

 

Figure 99. 

 For the Centroidal option, the contouring is based on the centroidal forces for all 
shells around the column head node. 

 

Figure 100. 

For the Nodal option, the contouring is based on the nodal force at the column 
head node for all shells around the column head node.  

The Average option is the sum of the centroidal and nodal values divided by two. 
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As well as these direct deflections, forces and moments S-FRAME can also 
produce contours of information appropriate for the concrete design. Click the 

Slab Design Contours Tool ( ). You will then see a display of the contours for the 
Mx Top Wood-Armer. 

 
 

The maximum Mx moment +187 kNm (centroidal), 432 kNm (nodal). 

 You will see that there are options for contouring Mx Wood-Armer Bottom, Mx 
Wood-Armer Top, My Wood-Armer Bottom, X-Steel Top, X-Steel Bottom, Y-Steel 
Top and Y-Steel Bottom. 

Wood and Armer Moment Adjustments - In this example (and for most 
reasonably regular models) the reinforcement will tend to be aligned with the 
principle stress directions and Mxy twisting moments tend to be low where the 
peak hogging and sagging occurs. In such cases, Wood and Armer adjustments 
are not very significant. However, for irregular models, it is important that you take 
account of these adjustments. 

 
 

If you switch back to the Shell Contours Tool, pick one of the S/Sxy 
Max/Min Top/Mid/Btm options, then access the Contour Diagram 
Options dialog and check the option to Hide principle stress contours, 
then you can see arrows representing the directions in which these 
stresses run for each shell. In some complex models, this may help you 
to decide on the best reinforcement orientation. 

 

Figure 101. 

If you have changed to the Shell Contours Tool, then don’t forget to 
return to the Slab Design Contours Tool and choose the option to 
display Mx Bot Wood Armer moments before proceeding. 

 Sagging Moments – Comparison & Adjustment- The code approach for this 
model suggests a peak sagging moment of 120 kNm/m after re-distribution. 

 
 

The moment before re-distribution would have been. 

763
877

𝑥𝑥120 = 104 𝑘𝑘𝑘𝑘𝑘𝑘/𝑘𝑘 
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 Finite element analysis shows results ranging from 105 kNm/m (centroidal) to 115 
kNm/m (nodal) before any accounting for re-distribution. Therefore we see an 
excellent correlation between finite element and traditional idealized strip 
analysis. This leaves the question “do you still need to do something to cater for 
pattern loading.” Some would suggest that this is not necessary. However, 
according to the code we probably do need to cater for this (especially if you are 
going to design for the peak nodal results which expose local peaks without 
averaging them into strips). Moment redistribution is not an option, so we suggest 
that you consider a simpler approach and perhaps simply amplify the design 
sagging moments by something between 10 and 20%. 

Hogging Moments – Comparison & Adjustment- The code approach for this 
model suggests a peak hogging moment of 212 kNm/m after re-distribution. 

 
 

The moment before re-distribution would have been. 

212
0.8

= 265 𝑘𝑘𝑘𝑘𝑘𝑘/𝑘𝑘 

 The code requires you to reinforce for peak moments as though they are constant 
over quite significant strip widths. Any finite element analysis will expose more 
intense peaks that occur over shorter distances. S-FRAME provides options which 
allow you to interpolate across a width of the slab, and thus iron out these peaks. 
This is in effect an averaging option but the zones over which the results are 
averaged relate to the mesh density. In this example the three options show peak 
design hogging moments varying from: 

• Centroidal — 187 kNm/m  
• Average — 310 kNm/m  
• Nodal — 432 kNm/m  

 
 

You need to change to the display of Mx Top Wood Armer moments to 
expose these values. 

 If you were able to take the time to sub-divide all the shells in this model so that 
there a much finer mesh (14 segments between column heads) then the results 
change as follows: 

• Centroidal — 291 kNm/m 
• Average — 413 kNm/m 
• Nodal — 535 kNm/m 

The more finely you mesh, the higher are the peak values that are exposed.  

• With 7 nodes between columns, the peak nodal moment is effectively an 

average over a length of:  1
7

x 8 = 1.14 𝑘𝑘 

• With 14 nodes between columns, the peak nodal moment is effectively an 

average over a length of:  1
14

x 8 = 0.57 𝑘𝑘 

p. 69



Altair S-FRAME 2021.1 
Modeling Hints and Tips

Proprietary Information of Altair Engineering 

 Since these relate to the mesh density (node spacing), they become ever more 
irrelevant in terms of the code’s advice that you provide uniform reinforcement 
over a central strip width equal to 1/4 of the column spacing (in this case a 2 m 
wide strip). What you really need to be able to do is define a strip across a column 
head and have the average results reported to you on the basis of the strip width 
you choose. S-FRAME allows you to do just this. 

When viewing any contour diagram you can cut a strip simply by clicking on two 
nodes to define the start and end of the line, and then a third node to set the 
plane of interest. 

 

Figure 102. 

 
 

When you are using this option, we would recommend that you work 
on a 2D plane. To do this move the user coordinate system so that its XY 
plane lies along the plane in which you are interested. Click the Views 
icon ( ) and check the Work only with objects that fall within XY plane 
of current UCS +/- Delta Z option. If you do not do this, then you will 
find it impossible to define the strip if the nodes you need to pick to 
define the strip are coincident with other out-of-plane nodes in your 
current view. 
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 Below are the results for the above strip. This strip runs across the column heads 
and has the potential to expose the peak hogging moments. 

 

Figure 103. 

 
 

The Diagram Type is set to Along Line Only which means that the 
values shown are those directly along the line which you identified by 
your first two points. 

Furthermore, the number of Line Stations is taken along the entire line. 
S-FRAME only determines the moments at these stations, and not at 
any intermediate points. If you want greater accuracy, then you might 
consider increasing the number of stations and dealing with your strip 
in smaller lengths (for example between adjacent column heads). 

 The capture below shows the difference which specifying a different number of 
Line Sections makes. 

 

Figure 104. 
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In practice, if you are going to look at long strips you should take the 
time to ensure that the number of Line Stations which you specify does 
pick up the worst points along your line. 

 If you set the diagram type to Along Line but integrate over strip then you can 
enter the width of the strip in which you are interested and S-FRAME reports the 
total (integrated) moment over the specified width – in the capture below this is 2 
m. 

Hence the design moment based on this strip width is 319 kNm/m. This still seems 
somewhat high, and we need to ask why? The main reason is probably related as 
much to the modeling as to the methods of exposing and interpreting the results. 

It would make sense to create a more sophisticated model with rigid zones 
extending from the idealized column centre-line to their faces. Once you have 
done this, you can use panel meshing as before. 

If you want to pick up the model at this stage, then load the model Flat Slab Model 
Stage 3.TEL. This model has been created using the solution proposed above and 
with extra meshing to cater for these rigid arms. 

 

Figure 105. 

Using the Nodal contouring option, the peak hogging moment is significantly 
reduced from 432 to 331 kNm/m. 

p. 72



Altair S-FRAME 2021.1 
Modeling Hints and Tips

Proprietary Information of Altair Engineering 

 

Figure 106. 

 If we take the results for a 2 m wide strip running from one column head to the 
next, then the results are as shown below: 

 

Figure 107. 

The peak moment is now 260 kNm/m which looks very reasonable when 
compared with the estimated 265 kNm/m (before redistribution) using the code’s 
equivalent frame approach. 

You can also look at the sagging design moment on this section for a 4 m wide 
strip. 
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Figure 108. 

This gives a result of 102 kNm/m. 

Design Moments – Comparison / Discussion - We have shown that contouring 
and strip results are all dependent on mesh densities, the modeling sophistication, 
and the methods used to include or average out analytical peaks. 

 We have also shown that by using a combination of a more sophisticated model 
and strip averaging options some very reasonable results can be achieved.  

The design sagging moment has been established in different ways. For this 
alternative model the results are as follows:  

• by contouring based on nodal forces – 130 kNm/m  
• by contouring based on centroidal forces – 115 kNm/m  
• by cutting a strip and averaging across a 4 m width – 102 kNm/m  

As noted previously, the code indicates that pattern loading should be considered, 
You have the option to manually pattern the loads, but you might also consider 
making some sort of adjustment to the sagging design moments. For the 
averaged strip moments 15% to 20% adjustment is necessary to achieve a design 
moment in the region of the 120 kNm/m suggested by the code. However, if the 
design is to be based on the local peaks exposed by contouring based on nodal 
forces, then little or no adjustment seems necessary in this example. Using this 
model, it seems that you could conclude that the design sagging moment should 
be somewhere between  

1.2 x 102 = 122 kNm/m and 130 kNm/m.  

Bearing in mind these relationships established by looking at the code approach 
the peak design hogging moment over the column is expected to be a little less 
than double the peak sagging moment – 130 x 2 = 260 kNm/m. For this model, a 
result of 265 kNm/m has been shown. This is still higher than the peak value 
suggested by the code, but that applies after redistribution.  

p. 74



Altair S-FRAME 2021.1 
Modeling Hints and Tips

Proprietary Information of Altair Engineering 

If the contour/strip results are not looking close to this sort of relationship, then 
closer examination/checking is appropriate. 

Summary Codes do not offer guidance for complex flat slab models. (only more simple 
regular models), therefore you can only make a comparison between the code and 
S-FRAME for these regular models.  

For sagging moments finite element and code results are easily and well matched.  

Using strip options (and more detailed modeling where necessary) S-FRAME also 
gives similar results to code for the hogging moments.  

The above principles are equally applicable to and can be used on, more complex 
models.  

However, when using a finite element analysis for flat slab design, remember:  

• to consider the need to amplify the sagging moments to allow for pattern 
loading,  

• to adjust the stiffness value EI to allow the analysis to estimate long-term 
cracked section deflections.  

Using contours for a 
Wall - Example 

If you want to work through this example with us, then load the model Shells 
Example 1 Stage 1.TEL. In this example, a shear wall and frame are subjected to a 
total lateral loading of 250 kN (50 kN per floor). 

 

Figure 109. 
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This model has a number of notable points: 

• it is a 2D frame modeled in 3D. Therefore default out of plane 
constraints have been applied, 

• where beams meet shells in the same plane the two element types 
will not, by default, interact in such a way as to generate a moment 
connection. This is a common feature of analysis models. In order to 
generate a moment connection between the beams and the wall 
lacer elements have been threaded through the wall. (Another 
commonly accepted model that generates the fixity is to create a 
fan of elements from the beam end to all the adjacent nodes in the 
wall), 

• you can see the local x-axis of all the shells. In general, these have all 
been aligned, with one highlighted exception. 

 Analyze the model and then select the Standard 3D view in the Graphical Results 
window. 

Select the Membrane Forces Tool and S-FRAME displays color coded element 
center forces. 

 

Figure 110. 

In this example, the local y for all the elements (except the one highlighted 
previously – the second-to-right, second-to-bottom shell) are aligned with the 
Global Z axis as shown. The exception’s local x-axis has been rotated by 90° and is, 
therefore, parallel to the global Z axis.  

If you examine the results closely, you will see that the results for this shell don’t fit 
into the expected pattern of stressing – which should run from high tension at the 
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left to high compression at the right. This is because the force for this element is 
actually that at 90° to the forces for all the other elements.  

Using contouring, we can see all sorts of results in relation to one consistent 
coordinate system. However, if you simply select the Shell Contours Tool and try to 
view results for the vertical loading in this wall (Fz) you will find that there is no 
such option. 

You can only view contours for Fx and Fy. (While in this particular case the 
additional Fz option might appear to make sense, this would be no good if the 
wall were at some arbitrary angle.) Generally in order to see sensible contour 
results (for both forces and stresses) you need to use an adjusted user coordinate 
system with the X- and Y-axis in the plane of the shells under consideration. 

 
 

For details of the sign conventions relating to shell elements, see 
Coordinate Systems and Local Axes in Chapter 2 of the S-FRAME 
Verification Manual. 

For further information on user coordinate systems see “Using user 
coordinate systems” on the Introduction Manual – 3D Tutorial. 

 Select the Wall 1 user coordinate system for this model, and you will start to see 
meaningful contouring for Fy forces. The view below shows a top view which 
always looks down onto the current XY-plane. 

 

Figure 111. 

 
 

You may find it useful to save a 2D view of each wall or panel for a 
model with numerous panels in numerous different planes. The next 
example (a “box” model) illustrates this point nicely. 
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 Finally, you may want to see wall panel design forces. Once again you can achieve 
this by cutting a strip through the wall. Simply click on two nodes to define the 
start and end of the line, and then a third node to set the plane of interest. 

 

Figure 112. 

 
 

It is easier to click the 3rd node as shown above since this node is not 
masked by the contouring. The actual location of the node is immaterial 
since it is only used to set the direction of the plane. 

 
 

In this case, there is no need to work on a 2D plane since this is a 2D 
model which is modeled in 3D. 

 You will see the Concrete Slab or Wall Design dialog. Since we are dealing with a 
wall, click the Wall tab. 

 

Figure 113. 

This shows you the forces in the wall along the plane which you picked. These 
results can be used as panel force input for wall design in W-Sect. 
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Using Contours for a 
Box - Example 

If you want to work through this example with us, then load the model Shells 
Example 2 Stage 1.TEL. 

 

Figure 114. 

 
 

A common question you ask is how to go about modeling 

things such as: 

• tank lids that bear on and laterally restrain tank walls, but with no 
transfer of moment across the joint, 

• continuous slabs that bear on steel beams but which can rotate on 
the top flange, 

• slab discontinuities. 

In all cases, you can separate the discontinuous panels within the model 
and then slave the elements in order to model the correct interaction. 

In this example, we raise the Lid above the tank walls and slave the 
perimeter joints at the top of the walls and the corresponding joints at 
the edge of the lid. 

 
 

If you use the Edit > Start Numbers menu option to preserve number 
sequences during copy/paste operations, you can slave the joints very 
quickly using the Spreadsheet window. 

If you limit slaving to two opposite edges, you can achieve a one-way-
spanning load distribution. 

 The model has two load cases, the first is pressure on the lid (shown below), the 
second is an outwards pressure on each of the four walls. 
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Figure 115. 

 Run a linear static analysis on this model, select the Shell Contours Tool, the Mx 
contours option for the lateral load case and you should see the result below. 

 

Figure 116. 

 
 

The analysis will issue FYI (information) messages, in this case, these 
indicate that no Mz restraints have been applied to the lid, in practice, 
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the slaving arrangement means that there is no instability and you can 
ignore this message. 

 The current coordinate system has it’s XY-plane in the plane of the tank base. 
Although the details for the front and back walls look tantalizingly correct they are 
not. Contouring the walls relative to this user coordinate system is, to put it 
bluntly, nonsense. 

You can customize the view by right-clicking on the Shell Contours Tool to display 
the Contour Diagram Factors dialog. If your view is not the same as that above, 
adjust your view settings to those shown below. 

 

Figure 117. 

 Select the Front Wall user coordinate system that has been set up in this model, 
and you can move towards seeing meaningful contouring for the Mx forces on the 
front wall. 

 

Figure 118. 
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Bear in mind that this is a symmetrical model, symmetrically loaded. It is 
obvious that the contouring above is not symmetrical. This indicates the 
importance of contouring relative to an appropriate coordinate system. 

Mx moments are those that act on (not around) the X-axis – so, in this 
case, they are the moments for the horizontal span of the wall. 

The range of forces reported for this front wall as shown in the legend 
are in the range ±12.9 kNm / m. 

 Click on the Wall 1 – Front group to see the results for only the front wall. 

 

Figure 119. 

 You will now see that the range of forces reported for the front wall are in the 
range +12.9 to -16.5 kNm/m. We need to ask ourselves “Why is there this 
difference?” 

The answer is that S-FRAME always interpolates between adjacent selected shells 
when it is producing contours. Click on the Wall 3– Left group, and you will see 
the results for the left wall. 
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Figure 120. 

With the current coordinate system, there are no forces in the Mx direction in the 
left wall. Thus when both the front wall and side walls were selected S-FRAME 
adjusted the front wall contouring to take account of the zero values in the side 
walls. This illustrates the importance of ensuring that you only select the shells in 
which you are interested, and for which the current user coordinate system is 
valid. 

It should be becoming obvious that you need to set up several coordinate systems 
to be able to see meaningful results for each wall. Even if you do this, you might 
find that your view of one wall’s results gets obscured by the others. It is here that 
the Views feature becomes particularly important for models with shells. 

 
 

For further information see “Using Views” on the Introduction Manual 
– 3D Tutorial. 

 A view includes details of the current coordinate system, the current folder, and 
can also be marked as a 2D view (that is it will only show elements that exist in the 
current XY-plane). Therefore, although it takes a little time to set up, we think that 
it is well worth saving a view for each panel in a model such as this. You will find all 
the views you need in this model. 
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 Select the Wall 3 – Left view and you will see the Mx forces on that wall. 

 

Figure 121. 

 
 

As expected, the Mx moments in this wall are the same as for the front 
wall. 

 Now right click on the Shell Contours Tool to display the Contour Diagram Factors 
dialog. Choose the Nodal interpolation option as shown below and click Ok. 

 

Figure 122. 
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 You will now see that the range of forces changes in the contoured diagram. 

 

Figure 123. 

You will now see that the range of forces reported for the left wall are in the range 
+14.9 to -30.7 kNm/m. Again we need to understand why there is this difference. 
It is in the way that S-FRAME determines the forces in each node for contouring 
purposes. This has been covered previously. 

 
 

For further information, please see “To make contour diagram 
settings” topic in the S-FRAME Help System. 

 Right click on the Shell Contours Tool to display the Contour Diagram Factors 
dialog. Choose the Centroidal interpolation option and click Ok.  

Finally, let’s look at Von Mises Stresses for the entire model. Select Von Mises Top 
from the list of contouring options and the Standard 3D view.  
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Figure 124. 

 Here we do see a degree of symmetry starting to arise. However contouring 
relative to a common UCS is not supported for Von Mises, Smax, Smin, and Sxymax 
contouring options. When these options are selected, the local Z is used to define 
the top / middle / bottom surface. Hence you will find that checking the# option 
to Display in element coordinates makes no difference for these contouring 
options because they are always displayed in element coordinates, the local z 
direction being the only important aspect of the coordinate system for any of 
these options. If you intend to use these options, it is, therefore, important that 
you define your elements with a common local Z-direction. This can often be 
achieved by defining your elements in a consistent clockwise or counter-clockwise 
manner. However, in some cases you will need to deviate from this - containers for 
example (see the documented box model) in such cases you might think of outer 
and inner surfaces and so you need to reverse your convention on opposite walls. 
so if we were to reverse the local z-axes on the back wall of this box so that all local 
z-axes either point out (or in) then the Von Mises contouring would be 
symmetrical.  

For more detail on the derivation of Von Mises stresses, refer to the next 
section.This appears to show virtually no stresses in the walls, but again this is a 
function of the current user coordinate system, on which the contouring is based. 
We have chosen to see the Von Mises Top stresses, but Top means the face on the 
positive Z-side of the shells, and since the Z-axis is in the plane of the walls this 
again is inappropriate.  

 
 

For a further example looking at the influence of coordinate systems 
and interpolation options when contouring, see Example 22 - 
Cylindrical roof static analysis in Chapter 3 of the S-FRAME 
Verification Manual. 
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Overview of 
Maximum Shear 
Criterion 

The information below is extracted from the efunda (engineering fundamentals) 
website; you can find the full version (and much more of interest) at: 

http://www.efunda.com/formulae/solid_mechanics/failure_criteria/failure_criteria_ductile.cfm 

The maximum shear stress criterion, also known as Tresca's or Guest's criterion, is 
often used to predict the yielding of ductile materials. Yield in ductile materials is 
usually caused by the slippage of crystal planes along the maximum shear stress 
surface. Therefore, a given point in the body is considered safe as long as the 
maximum shear stress at that point is under the yield shear stress obtained from a 
uniaxial tensile test. With respect to 2D stress, the maximum shear stress is related 
to the difference in the two principal stresses. Therefore, the criterion requires the 
principal stress difference, along with the principal stresses themselves, to be less 
than the yield shear stress, 

 

Graphically, the maximum shear stress criterion requires that the two principal 
stresses be within the green zone indicated below. 

 

Von Mises 
Criterion 

The von Mises Criterion (1913), also known as the maximum distortion energy 
criterion, octahedral shear stress theory, or Maxwell-Huber-Hencky-von Mises 
theory, is often used to estimate the yield of ductile materials. 

The von Mises criterion states that failure occurs when the energy of distortion 
reaches the same energy for yield/failure in uniaxial tension. Mathematically, this is 
expressed as, 

 

In the cases of plane stress, σ3 = 0. The von Mises criterion reduces to,  
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 This equation represents a principal stress ellipse as illustrated in the following 
figure, 

 

Also shown on the figure is the maximum shear stress criterion (dashed line). 
This theory is more conservative than the von Mises criterion since it lies inside the 
von Mises ellipse. 

In addition to bounding the principal stresses to prevent ductile failure, the von 
Mises criterion also gives a reasonable estimation of fatigue failure, especially in 
cases of repeated tensile and tensile-shear loading. 

Principal 
Directions, 
Principal Stress 

The normal stresses ( σx’and σy’ ) and the shear stress (τx’y’) vary smoothly with 
respect to the rotation angle , in accordance with the coordinate transformation 
equations. There exist a couple of particular angles where the stresses take on 
special values.  

First, there exists an angle where the shear stress becomes zero. That angle is 
found by setting τ τx’y’ to zero in the above shear transformation equation and 
solving for q (set equal to θp). The result is, 

 

The angle θp defines the principal directions where the only stresses are normal 
stresses. These stresses are called principal stresses and are found from the original 
stresses (expressed in the x,y,z directions) via, 
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 The transformation to the principal directions can be illustrated as: 

 

Maximum Shear 
Stress Direction 

Another important angle, θs, is where the maximum shear stress occurs. This is 
found by finding the maximum of the shear stress transformation equation and 
solving for θ. The result is, 

 

The maximum shear stress is equal to one-half the difference between the two 
principal stresses, 

 

The transformation to the maximum shear stress direction can be illustrated as: 
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Example This 5 m square, 250 mm thick slab has a uniform area load of 10 kN/m2. 

 
Model. 

 
Normal Stress - Sxx 

 
Principal Stress - Smax 

 
Von Misses Stress 

 

Consider Shell Number 9 

Normal Stress, Sxx  σx = 0.268 N/mm2  calculated by S-Frame 
Normal Stress, Syy  σy = 0.268 N/mm2  calculated by S-Frame 
Shear Stress, Sxy  σxy = 0.143 N/mm2  calculated by S-Frame 

 

Principal Stresses 

Max Principal Stress, 
Smax  

 

= 0.411 N/mm2 

Min Principal Stress, 
Smin  

 

= 0.125 N/mm2 

Angle 𝜃𝜃𝜌𝜌 =
1
2

 𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎[
2𝜏𝜏𝑥𝑥𝑥𝑥

𝜎𝜎𝑥𝑥 − 𝜎𝜎𝑥𝑥
] = 45° 

 
Von Mises Stress 

Von Mises Stress 𝜎𝜎𝑥𝑥 = �𝜎𝜎12 − 𝜎𝜎1𝜎𝜎2 + 𝜎𝜎22 
= 0.365 N/mm2 
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S-FRAME Results The results from the S-FRAME analysis are shown in the following table: 

Shell Location Sxx 
N/mm2 

Syy 
N/mm2 

Sxy 
N/mm2 

Smax 
N/mm2 

Smin 
N/mm2 

Angle 
Deg 

Von 
Mises 

N/mm2 

1 Top 0.1588 0.1588 0.1391 0.2979 0.0196 45 0.2886 
 

Middle 0 0 0 0 0 0 0 
 

Bottom -0.1588 -0.1588 -0.1391 -0.0196 -0.2979 -45 0.2886 

2 Top 0.0394 0.3443 0.138 0.3975 -0.0138 68.9203 0.4046 
 

Middle 0 0 0 0 0 0 0 
 

Bottom -0.0394 -0.3443 -0.138 0.0138 -0.3975 -21.0797 0.4046 

3 Top 0.0399 0.4543 0 0.4543 0.0399 -90 0.4358 
 

Middle 0 0 0 0 0 0 0 
 

Bottom -0.0399 -0.4543 0 -0.0399 -0.4543 0 0.4358 

4 Top 0.0394 0.3443 -0.138 0.3975 -0.0138 -68.9203 0.4046 
 

Middle 0 0 0 0 0 0 0 
 

Bottom -0.0394 -0.3443 0.138 0.0138 -0.3975 21.0797 0.4046 

5 Top 0.1588 0.1588 -0.1391 0.2979 0.0196 -45 0.2886 
 

Middle 0 0 0 0 0 0 0 
 

Bottom -0.1588 -0.1588 0.1391 -0.0196 -0.2979 45 0.2886 

6 Top 0.3443 0.0394 0.138 0.3975 -0.0138 21.0797 0.4046 
 

Middle 0 0 0 0 0 0 0 
 

Bottom -0.3443 -0.0394 -0.138 0.0138 -0.3975 -68.9203 0.4046 

7 Top -0.2673 -0.2673 0.1431 -0.1243 -0.4104 45 0.3645 
 

Middle 0 0 0 0 0 0 0 
 

Bottom 0.2673 0.2673 -0.1431 0.4104 0.1243 -45 0.3645 

8 Top -0.3999 -0.3676 0 -0.3676 -0.3999 -90 0.3848 
 

Middle 0 0 0 0 0 0 0 
 

Bottom 0.3999 0.3676 0 0.3999 0.3676 0 0.3848 

9 Top -0.2673 -0.2673 -0.1431 -0.1243 -0.4104 -45 0.3645 
 

Middle 0 0 0 0 0 0 0 
 

Bottom 0.2673 0.2673 0.1431 0.4104 0.1243 45 0.3645 

10 Top 0.3443 0.0394 -0.138 0.3975 -0.0138 -21.0797 0.4046 
 

Middle 0 0 0 0 0 0 0 
 

Bottom -0.3443 -0.0394 0.138 0.0138 -0.3975 68.9203 0.4046 

11 Top 0.4543 0.0399 0 0.4543 0.0399 0 0.4358 
 

Middle 0 0 0 0 0 0 0 
 

Bottom -0.4543 -0.0399 0 -0.0399 -0.4543 90 0.4358 

12 Top -0.3676 -0.3999 0 -0.3676 -0.3999 0 0.3848 
 

Middle 0 0 0 0 0 0 0 
 

Bottom 0.3676 0.3999 0 0.3999 0.3676 90 0.3848 

13 Top -0.5542 -0.5542 0 -0.5542 -0.5542 0 0.5542 
 

Middle 0 0 0 0 0 0 0 
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Bottom 0.5542 0.5542 0 0.5542 0.5542 0 0.5542 

14 Top -0.3676 -0.3999 0 -0.3676 -0.3999 0 0.3848 
 

Middle 0 0 0 0 0 0 0 
 

Bottom 0.3676 0.3999 0 0.3999 0.3676 -90 0.3848 

15 Top 0.4543 0.0399 0 0.4543 0.0399 0 0.4358 
 

Middle 0 0 0 0 0 0 0 
 

Bottom -0.4543 -0.0399 0 -0.0399 -0.4543 -90 0.4358 

16 Top 0.3443 0.0394 -0.138 0.3975 -0.0138 -21.0797 0.4046 
 

Middle 0 0 0 0 0 0 0 
 

Bottom -0.3443 -0.0394 0.138 0.0138 -0.3975 68.9203 0.4046 

17 Top -0.2673 -0.2673 -0.1431 -0.1243 -0.4104 -45 0.3645 
 

Middle 0 0 0 0 0 0 0 
 

Bottom 0.2673 0.2673 0.1431 0.4104 0.1243 45 0.3645 

18 Top -0.3999 -0.3676 0 -0.3676 -0.3999 -90 0.3848 
 

Middle 0 0 0 0 0 0 0 
 

Bottom 0.3999 0.3676 0 0.3999 0.3676 0 0.3848 

19 Top -0.2673 -0.2673 0.1431 -0.1243 -0.4104 45 0.3645 
 

Middle 0 0 0 0 0 0 0 
 

Bottom 0.2673 0.2673 -0.1431 0.4104 0.1243 -45 0.3645 

20 Top 0.3443 0.0394 0.138 0.3975 -0.0138 21.0797 0.4046 
 

Middle 0 0 0 0 0 0 0 
 

Bottom -0.3443 -0.0394 -0.138 0.0138 -0.3975 -68.9203 0.4046 

21 Top 0.1588 0.1588 -0.1391 0.2979 0.0196 -45 0.2886 
 

Middle 0 0 0 0 0 0 0 
 

Bottom -0.1588 -0.1588 0.1391 -0.0196 -0.2979 45 0.2886 

22 Top 0.0394 0.3443 -0.138 0.3975 -0.0138 -68.9203 0.4046 
 

Middle 0 0 0 0 0 0 0 
 

Bottom -0.0394 -0.3443 0.138 0.0138 -0.3975 21.0797 0.4046 

23 Top 0.0399 0.4543 0 0.4543 0.0399 90 0.4358 
 

Middle 0 0 0 0 0 0 0 
 

Bottom -0.0399 -0.4543 0 -0.0399 -0.4543 0 0.4358 

24 Top 0.0394 0.3443 0.138 0.3975 -0.0138 68.9203 0.4046 
 

Middle 0 0 0 0 0 0 0 
 

Bottom -0.0394 -0.3443 -0.138 0.0138 -0.3975 -21.0797 0.4046 

25 Top 0.1588 0.1588 0.1391 0.2979 0.0196 45 0.2886 
 

Middle 0 0 0 0 0 0 0 
 

Bottom -0.1588 -0.1588 -0.1391 -0.0196 -0.2979 -45 0.2886 

Table 4. 
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Creating Curved 
Members 

Curved sections are increasingly used in constructional steelwork. They combine 
design efficiency with strong aesthetic appeal; providing excellent value for 
money. 

Whilst not covered specifically by many design codes, designers cope well with 
special considerations required for such sections both in terms of analysis and 
design. 

Whenever we are asked if we support curved analysis members, we advise that 
you model the curve as series of straight members. Since this is a common issue, 
we give guidance below on the best way of building these sections into a 3D 
analysis model. 

The process  The following pages detail how you can create curved members within S-FRAME. 

Before you generate the curved member you need to know: 

• its rise, r 
• its span, L 
• the number of nodes that you want to use to define the curved member, n.  

These are indicated in the diagram below. 

 

Figure 125. 

These terms can be used to calculate:  

• the radius of the curved member, where 𝑅𝑅 =  
𝐿𝐿2
4 +𝑟𝑟

2

2𝑟𝑟
 

• the angle through which the x-axis would rotate to cut through the first 

node, θ, where 𝜃𝜃 = acos ( 𝐿𝐿
2𝑅𝑅

) 

• the angle through which the curved member will sweep between two 

nodes, δθ, where 𝛿𝛿𝜃𝜃 = 2 (90−𝜃𝜃)
(𝑛𝑛−1)

  

 
 

For maximum accuracy, the angles and should be recorded to 6 decimal 
places. 
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 Once these variables have been calculated, they can be used to specify the curved 
member in S-FRAME or P-FRAME. 

Moving the user 
coordinate system 

1. From the Toolbox select the User Coordinate System Tool (UCS) with a click 
of the left mouse button. A click of the right mouse button will then open the 
dialog.  

2. Move the user coordinate system to where the curved member is to begin. 
This is where the first node will be placed. To move the user coordinate 
system enter its new coordinates into the Data Bar. Alternatively, if there is a 
node already at the required position click on that node.  

 

Figure 126. 

3. Now place the user coordinate system at the center of the circle forming your 
curved member. Move the user coordinate system a distance L /2 along the X-
axis and (r – R ) along the Y-axis.  

4. Select Save UCS. Give the coordinate system a name and set the UCS type to 
Cylindrical. Click on OK.  

 

Figure 127. 

 
 

Before going any further, ensure that no items are currently selected 
using Unselect All in the menu bar. 
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Define the Joints 1. Select Joint Tool from the Toolbox and then click on the right mouse button 
to display the Joint Tool dialog. 

2. Set the Coordinate System to Cylindrical (Polar for P-FRAME). 

 

Figure 128. 

 3. Set the following values:  
• radius = R ,  
• Theta = θ ,  
• Delta theta = δθ,  
• Number = n – 1 ,  
• Delta r = 0 

 
For S-FRAME you will also need to set the values:  

• Z =0 ,  
• Delta Z = 0  

4. To create these points select Generate and then OK. 

 
 

If you choose OK but do not generate the points first, then no joints will 
appear. 

 In the Geometry window, the specified points will now have been drawn. 

 

Figure 129. 
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Define the Members In a curved member containing a large number of nodes, it is best to draw one of 
the members and then copy this to the other locations.  

1. Ensure that only the two right-hand nodes are selected.  
2. Select Member Definition with a click of the left mouse button.  
3. Draw a member between these two nodes by a click of the left mouse button 

on each of the joints in turn. 

 

Figure 130. 

4. Choose Edit > Copy. From the Toolbox select the Clone Tool and then click on 
the right mouse button to display the Clone Tool dialog. Choose Rotation as 
the Generation method.  

5. The only fields that need to be amended are Z rot, Number, and Delta Z rot. 
Set these as follows:  

• Z rot = δθ, 
• Delta Z rot = δθ,  
• Number = (n-3).  

All others can be left as zero. 

 6. Choose OK. In the Geometry window, the remaining members will now have 
been drawn. 

 

Figure 131. 
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Rotating a Curved 
Member in S-FRAME 

In S-FRAME it is necessary to move the curved member from the horizontal XY-
plane in which it has been generated into a vertical plane, either YZ or XZ.  

To move it into the YZ-plane go to the Edit menu and select Move. 

 

Figure 132. 

 

Figure 133. 

 
 

To move your curved member into the XZ- rather than the YZ-plane, 
enter an X Rotation value of 90 degrees. 

If the ends of the curved member overlap existing joints, the program 
will detect this and delete the duplicate joints. If this occurs, you may 
need to redefine the deleted members. 

 

p. 97


	S-FRAME Detailed ModelingHints and Tips
	Intellectual Property Rights Notice
	Manual Setup and Conventions
	Contents
	Detailed Modeling Hints and Tips
	Reviewing your model
	Rendering
	Using Folders
	Why Use Folders?
	How do you create folders?

	Making and clearing selections
	Graphical Selection Options
	Menu Selection Options
	Folder Selection

	Using user coordinate systems
	Creating and saving user coordinate systems (UCS)
	Example

	Using Views
	Why use Views?
	Example 1
	Example 2

	Using grids to create your model
	Using grids to edit your model
	Example

	Generating Arrays of Equally Spaced Floor Joists
	Example

	The Clone Tool
	Other generation options
	Create regular frameworks
	Generate trusses
	Generate meshes
	Generate physical/ analytical models
	Subdividing (selected) elements
	Using rigid diaphragms
	Example
	Creating a diaphragm

	Using panels
	Defining area loads
	Example

	Connecting overlapping joints (merging structures)
	Connecting intersecting members
	Defining Moving Loads
	Example
	Reviewing moving load results

	Reviewing and Printing Results for Beam Elements
	Using Shell Contours and Slab Design Contours
	Using Contours for a Flat Slab
	Example
	Summary
	Using contours for a Wall - Example
	Using Contours for a Box - Example

	Overview of Maximum Shear Criterion
	Von Mises Criterion
	Principal Directions, Principal Stress
	Maximum Shear Stress Direction
	Example
	S-FRAME Results

	Creating Curved Members
	The process 
	Moving the user coordinate system
	Define the Joints
	Define the Members
	Rotating a Curved Member in S-FRAME




